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RA2E3 Group 

RA2E3 HS4001 Low Power Sensor System Example 

Introduction 

This application note describes an application program which displays the data acquired by the HS400x 
humidity and temperature sensor operating with an RA Family device on an SSD1306 OLED module.  

This program uses Software Standby mode as a low power mode. Compared to the Normal mode, the 
Software Standby mode minimizes power consumption by stopping the CPU and most peripherals. The 
MCU spends a long time in Software Standby mode except for the wake-up interrupt handling every 500 
milliseconds and the OLED sensor data update processing every 4 seconds. The AGT is used to generate 
wake-up events. 

 

Target Device 

RA2E3  

When applying the sample program covered in this document to another MCU, modify the program 
according to the specifications for the target MCU and conduct an extensive evaluation of the modified 
program. 

 

Required Resources 

The resources required for this application program are as follows. 

Hardware 

 FPB-RA2E3 Fast Prototyping Board (RTK7FPA2E3S00001BE) 

 QCIOT-HS4001POCZ relative humidity sensor Pmod™ board (QCIOT-HS4001POCZ) 

 SSD1306 OLED module 

- Resolution: 128 x 64 dot matrix panel 

- Power supply: 3.3 V 

- Interface: I2C 

- Slave address: 0x3c (7-bit address) 

 Four jumper wires (male-to-female type) 

* A separate emulator is not required because on-board J-Link will be used. 

Development Tools and Software 

 e2 studio IDE version 2025-01  

 Renesas Flexible Software Package (FSP) version 5.8.0 

 GCC ARM Embedded Toolchain version 13.2.1.arm-13-7  
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1. Description 

1.1 Abstract 

This application program is used to display humidity and temperature in the room on the screen of an 
SSD1306 OLED module by using the RA2E3 Fast Prototyping Board (FPB-RA2E3) with the QCIOT-
HS4001POCZ relative humidity sensor Pmod™ board to acquire the temperature and humidity data. This 
program runs in Software Standby mode as a low power mode to suppress the operating time of the CPU to 
a minimum, thus reducing power consumption. 

The RA2E3 Fast Prototyping Board comes equipped with an RA2E3 MCU and is an evaluation board 
specialized for prototype development for a variety of applications. It has a built-in SEGGER J-Link™ On-
Board programmer/debugger so you can write/debug programs without additional tools. In addition, with 
Arduino Uno™ and Pmod™ interfaces included standard and through-hole access to all pins of the MCU, 
and so on, it has high expandability. 

HS4001 is a highly accurate, ultra-low power, and fully calibrated relative humidity and temperature sensor. 
The MEMS sensor features proprietary sensor-level protection ensuring high reliability and long-term 
stability. The HS4001 is fully calibrated, and temperature compensated with an I2C digital output. 

SSD1306 is a graphics display module controlled by I2C using a 128 * 64 organic light emitting diode 
(OLED). The display module is a representative IC with many libraries available for use with Arduino-
compatible boards, Raspberry Pi, etc. 

 

1.2 Main Technical Parameters 

Power Supply USB power supply (5 V) 

Operating Voltage (MCU) 3.3 V 

OLED Display Pattern 14 characters * 4 rows 
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1.3 Specifications 

 Detect indoor humidity and temperature with QCIOT-HS4001POCZ. 

 The AGT is used as the timer to control the acquisition of temperature and humidity data every 500 
milliseconds and updating of the display of temperature and humidity data on the OLED screen every 
four seconds. 

 The Software Standby mode is used as a low power mode to reduce power consumption. 

 

Figure 1.1 shows the MCU states and mode transition events, and Figure 1.2 shows a conceptual diagram of 
the operation modes and current consumption. 

 

 

 

Figure 1.1 MCU Status and Mode Transition Events 

 

 

 

Figure 1.2 Conceptual Diagram of Operation Mode and Current Consumption 
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2. RA2E3 MCU 

The RA2E3 group is an entry-line single-chip MCU in the RA family based on the 48 MHz Arm® Cortex®-M23 
core with up to 64KB code flash and 16KB SRAM memory.  

RA2E3 MCUs provide an optimized feature set for cost-sensitive applications. Ultra-low power consumption 
contributes to energy-efficient system design, required for IoT applications and battery-operated systems to 
achieve longer battery life. 

 

For more details of the RA2E3, please refer to the following link: 

http://renesas.com/ra2e3 

For more details of specifications, please refer to the following link: 

https://www.renesas.com/document/mah/ra2e3-group-users-manual-hardware 

RA2E3 User's Manual: Hardware (R01UH0992) 

 

2.1 Block Diagram of the RA2E3 

Figure 2.1 shows the block diagram of the RA2E3. 

 

Figure 2.1 Block Diagram of the RA2E3 

 

  

http://renesas.com/ra2e3
https://www.renesas.com/document/mah/ra2e3-group-users-manual-hardware
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2.2 RA2E3 Low Power Modes  

The table “Operating conditions of each low power mode” in the RA2E3 (R01UH0992) User's Manual 
describes the conditions for transitions to low power modes, the states of the CPUs and peripheral modules, 
and the condition for release from each mode. 

The available low power modes are as follows: 

 Sleep mode 

 Software Standby mode 

 Snooze mode 

 

The Software Standby mode minimizes power consumption by stopping the CPU and most peripherals while 
retaining the contents of SRAM. The MCU can wake up from this mode by an external interrupt, RTC alarm, 
or AGT underflow event. The following peripherals remain operational in Software Standby mode. 

 AGT (Low Power Asynchronous General Purpose Timer): Can continue counting and trigger wake-
up. 

 RTC: Can generate an alarm-based wake-up. 

 IRQ pins: Can wake up the MCU upon receipt of an external signal. 

 I2C and other communication peripherals: Remain disabled until a wake-up event occurs. 

 

3. System Outline 

3.1 Introduction 

The application program uses an RA2E3 MCU, a digital temperature and humidity sensor and OLED display 
module. After the MCU (RA2E3) has detected the temperature and humidity in the room, the user can check 
the data on the OLED screen. The AGT is used as the timer to control the acquisition of temperature and 
humidity data every 500 milliseconds and updating of the display on the OLED every four seconds. 

In addition, this program runs in Software Standby mode as a low power mode while CPU operation is not 
required. 

Figure 3.1 shows the system configuration.  

 

Figure 3.1 System Configuration 

 

3.2 Peripheral Functions to be Used 

Table 3.1 lists the peripheral functions to be used and their usage. 

Table 3.1 Peripheral Functions to be Used 

Peripheral Function Usage 

I2C (IIC0) 

 

Get data (temperature and humidity) from the sensors. 

Control the OLED to display temperature and humidity. 

AGT1 Count clock cycles every 500 milliseconds. 
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3.3 Pins to be Used 

Table 3.2 lists the pins to be used and their function. 

Table 3.2 Pins to be Used 

Pin Name Description 

P400/SCL0 Clock signal: Communicate with sensor (HS4001) and OLED through I2C bus 

P401/SDA0 Data signal: Communicate with sensor (HS4001) and OLED through I2C bus 

VDD Power-supply voltage 

GND Ground 

3.4 Operating Procedure 

1. Once power is supplied, system initialization begins. 

2. After initialization, the OLED (SSD1306) displays “RENESAS” and the demonstration title. 

3. The temperature and humidity data are acquired every 500 milliseconds after an interrupt by the AGT 
has been accepted. 

4. After the temperature and humidity data have been acquired, the MCU (RA2E3) operates in Software 
Standby mode as a low power mode and waits for the next interrupt from the AGT. 

5. The MCU (RA2E3) sends the temperature and humidity data that have been acquired to the OLED 
(SSD1306) every four seconds to update the display of the data on the OLED screen. 

 

Display pattern 

R E N E S A S 
       

F P B - R A 2 E 3 
 

D E M O 

T e m p 
 

x x . x C 
    

H u m i 
 

x x . x % 
    

 

4. Hardware 

This section describes the hardware products and configurations of connections used by the application 
program. 

For details of the QCIOT-HS4001POCZ, please refer to the following link: 

https://www.renesas.com/en/products/sensor-products/environmental-sensors/humidity-temperature-
sensors/qciot-hs4001pocz-relative-humidity-sensor-pmod-board 

For details of the SSD1306, please refer to the following link: 

https://www.solomon-systech.com/product/ssd1306/ 

Figure 4.1 shows the FPB-RA2E3 PMOD Interface. Figure 4.2 shows the connection of FPB-RA2E3, 
QCIOT-HS4001POCZ and SSD1306. 

https://www.renesas.com/en/products/sensor-products/environmental-sensors/humidity-temperature-sensors/qciot-hs4001pocz-relative-humidity-sensor-pmod-board
https://www.renesas.com/en/products/sensor-products/environmental-sensors/humidity-temperature-sensors/qciot-hs4001pocz-relative-humidity-sensor-pmod-board
https://www.solomon-systech.com/product/ssd1306/
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Figure 4.1 FPB-RA2E3 PMOD Interface 

 

 

 

Figure 4.2 Connection of FPB-RA2E3, QCIOT-HS4001POCZ and SSD1306 

 
Figure 4.3 shows the hardware configuration.  

Figure 4.3 Hardware Configuration 

 

 

FPB-RA2E3 

SSD1306 
 (OLED display module) 

QCIOT-HS4001POCZ 
(temperature/humidity sensor) 
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5. Software 

5.1 Integrated Development Environment 

The sample code described in this chapter has been checked under the conditions listed in Table 5.1. 

Table 5.1 Operation Check Conditions 

Item  Description  

Board  FPB-RA2E3 

Device  RA2E3 (R7FA2E3073CFL)  

Operating frequency  High-speed on-chip oscillator (HOCO) clock: 48 MHz 

System clock (ICLK): 48 MHz 

Peripheral module clock B (PCLKB): 24 MHz 

Peripheral module clock D (PCLKD): 48 MHz 

Operating voltage  3.3 V  

Integrated development environment 

(e2 studio)  

e2 studio 2025-01 

FSP  5.8.0 from Renesas Electronics Corp.  

Toolchain (GCC ARM Embedded)  13.2.1.arm-13-7 

HS4001 Library  HS400X Temperature/Humidity Sensor (rm_hs400x)  

Low Power Modes driver Low Power Modes (r_lpm)  

Timer driver Timer, Low-Power (r_agt)  

 

5.2 Operation Outline 

(1) Reset / Initialization 

When power is supplied to the system, it will enter the processing for initialization. Power is supplied to the 
OLED and the display is cleared. After that, it displays “Renesas Electronics” and other characters by 
default. HS4001 is initialized. IIC0 and I/O pins are also initialized. 

 

Figure 5.1 Initialized OLED Screen 

(2) Measurement mode 

After initialization, the MCU starts to get the sensor measurement data.  

(3) Display mode 

After measurement, the MCU sends the information to the OLED for display. 

  

Figure 5.2 Screen Displaying the Temperature and Humidity Data  
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5.3 Flowcharts 

5.3.1 Main Processing 

Figure 5.3 shows the flowchart of the main processing. 

 

 

 

Figure 5.3 Main Processing 
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5.3.2 Timer Interrupt Handling 

Figure 5.4 shows the flowchart of the timer interrupt handling. 

 

 

 

Figure 5.4 Timer Interrupt Handling 

 

  



Renesas RA Family RA2E3 HS4001 Low Power Sensor System Example 

R01AN7744EJ0100  Rev.1.00  Page 12 of 21 

May.07.25  

5.4 File Structure 

The file structure is shown below. 

 

Figure 5.5 File Structure 
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6. How to Add Middleware and Driver by Using the FSP in e2 studio 

This section introduces how to add the middleware and HAL driver stacks in the configurator. The introduced 
stacks are required for the application program. The application program can be used by importing the 
project. Refer to chapter 7, How to Import and Build the Project, for the procedure of importing. 

6.1 HS400X Temperature/Humidity Sensor 

1. Launch e2 studio. 

2. Create a new project. 

Select RA > RA2E3 > FPB-RA2E3 from […] for [Board]. 

 

Figure 6.1 Creating a New Project 

 

3. Add HS4001 sensor middleware to the [Stacks] tabbed page. 

New Stack > Sensor > HS400X Temperature/Humidity Sensor (rm_hs400x) 

 

Figure 6.2 Adding to the [Stacks] Tabbed Page 
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4. Add r_iic_master or r_sci_i2c according to the specifications of the target board.  

 

Figure 6.3 Adding r_iic_master or _r_sci_i2c 

 

5. Set the properties of the I2C master driver according to the specifications of the target board. 

Clicking on [I2C master driver] on the [Stacks] tabbed page displays the properties in the [Properties] 
window. 

  

Figure 6.4 Setting Properties of the I2C Master Driver 
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6. Set the pins to be used. The pins to be used can be checked on the [Pins] tabbed page. 

 

Figure 6.5 Checking Pins to be Used 

 

6.2 Low Power Modes 

1. Add the driver for the LPM peripheral to the [Stacks] tabbed page. 

New Stack > Power > Low Power Modes (r_lpm) 

2. Set details of Low Power Modes. 

At this time, select [Software Standby mode] for [Low Power Mode] and [AGT1 Underflow] under [Wake 
Sources]. 

 

Figure 6.6 Properties of Low Power Modes 
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3. Add the driver for the AGT peripheral to the [Stacks] tabbed page. 

New Stack > Timers > Low-Power (r_agt) 

4. Set details of the AGT. 

Set the timer period, clock source, etc. Here, select a sub-clock as the clock source. 

*In RA2E3, the LOCO can also be selected as the clock source for the AGT to reduce the BOM and 
save the I/O ports. In such cases, check the accuracy of the LOCO. 

 

Figure 6.7 Properties of the AGT 

 

6.3 I2C Communication Device 

1. Add the middleware for OLED to the [Stacks] tabbed page. 

New Stack > Connectivity > I2C Communication Device (rm_comms_i2c) 

2. Add the I2C Shared Bus 

Make the “I2C Shared Bus” selection for use since the temperature and humidity sensor and the OLED 
are connected in a multi-slave configuration. 

Use > g_comms_i2c_bus0 I2C Shared Bus (rm_comms_i2c) 

Figure 6.8 Adding the I2C Shared Bus 
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3. Configure the property of the I2C Communication Device. 

At this time, set the properties to the following. 

 Slave Address: 0x3c 

 Callback: oled_comms_i2c_callback 

 

Figure 6.9 Properties of the I2C Communication Device 

 

7. How to Import and Build the Project 

1. Launch e2 studio. 

2. Click on [File] in the display menu and select [Import]. 

3. The [Import] window is displayed. Open the [General] category, select [Existing Projects into 
Workplace], and click on [Next]. 

4. In the [Select archive file] form, select the project file. After selection, confirm that the specified project 
“RA2E3_HS4001LowPowerSensorSystemExample” is displayed in [Project] and click on [Finish]. The 
[Import] window is then closed. 

5. Open [configuration.xml] and click on [Generate Project Content] in the [Configurator] window. 

6. In Project Explorer, click on the project name to bring it focus. 

7. Select [Build Project] in the [Project] menu to start building. 

 



Renesas RA Family RA2E3 HS4001 Low Power Sensor System Example 

R01AN7744EJ0100  Rev.1.00  Page 18 of 21 

May.07.25  

8. How to Debug the Project for Low Power 

1. Click on [Run] in the display menu and select [Debug Configurations]. 

2. Under the [Debugger] tab, go to the [Connection Settings] sub-tab to configure the following 

 J-link 

Script File: CM_low_power_debug.JLinkScript 

Low Power Handling: Yes 

The script file is included with this application project and can be used by specifying it in the debug settings. 

* The script file is not applied to the project by default. If a debug connection is made without setting up a 
script file, the MCU may not correctly make the transition to LPM. Even if it does, the power consumption 
may be higher than expected. 

 

 

Figure 8.1 Specifying the Script File 

 

9. Tips on e2 studio for Debugging 

9.1 Displaying IO Registers 

Select the [Window] menu > [Show View] > [Other…] to open the [Show View] window, and then select 
Debug > IO Registers. 

When you enter the name of a register for reference in the search box, you can easily find the given register. 

Example: AGT registers 

  

Figure 9.1 Displaying IO Registers 
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9.2 Customizing the [IO Registers] View 

Right-click on the name of a register and select [Add to Selected Registers]. You can confirm that only the 
specified registers have been selected on the [Selected Registers] tabbed page. 

Example: AGT1 registers 

 

Figure 9.2 [Add to Selected Registers] 

 

 

Figure 9.3 Selected Registers 

 

9.3 Setting Breakpoints 

When the debugger is started, double-clicking on a line in the area where the addresses of the editor are 
displayed sets a breakpoint. 

If you right-click on a line in that area, you can directly select the type of breakpoints by selecting [Toggle 
Software Breakpoint] or [Toggle Hardware Breakpoint]. 
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Figure 9.4 Setting a Breakpoint 

 

Figure 9.5 Selecting the Type of Breakpoints 

 

10. Sample Program 

The sample program is available on the Renesas Electronics Website. 

 

11. Reference Documents 

The latest versions of the following documents are available on the Renesas Electronics Website. 

 RA2E3 Fast Prototyping Board (R20UT5128) 

https://www.renesas.com/document/mat/fpb-ra2e3-v1-users-manual 

 RA2E3 User's Manual: Hardware (R01UH0992) 

https://www.renesas.com/document/mah/ra2e3-group-users-manual-hardware 

 RA Family, RX Family, RL78 Family, RZ Family HS400x Sample Application (R01AN6333) 

  

https://www.renesas.com/document/mat/fpb-ra2e3-v1-users-manual
https://www.renesas.com/document/mah/ra2e3-group-users-manual-hardware


Renesas RA Family RA2E3 HS4001 Low Power Sensor System Example 

R01AN7744EJ0100  Rev.1.00  Page 21 of 21 

May.07.25  

Revision History 

Rev. Date 

Description 

Page Summary 

Rev.1.00 May.07.25 - First release 

    

 

 



 

 

General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of 

your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the 
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5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
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